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Chapter 1. Download and Installation 

 

Download Canvas software from  

http://www.jnxtec.com/GCxGC-Data-Processing-Software?_l=en 

or from any authorized distributors 

or copy the Canvas installation file from the USB drive in the product package.  

 

Click setup.exe to start installation. Follow the installation guide to complete 

Canvas installation. 

 

 

 

Canvas can be installed and used in multiple computers in the same group. 

However, sharing with a third party or commercial use is not allowed. Read the 

Free-Deployment and Full-Responsibility (FDFR) License before continuing 

installation.  

 

 

http://www.jnxtec.com/GCxGC-Data-Processing-Software?_l=en
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Select the installation path and continue installation. If the computer doesn’t 

have corresponding data conversion software (for Shimadzu .qgd or .gcd data, 

GC-solution or GCMS-solution is required; for thermo .raw data, Xcalibur is 

required), a warning message will prompt. Select “Continue” to skip if you do 

not need to process these data format. 

 

 

 

Open Canvas for the first time, an Activation Code is required, and the 

Authentic Check window will appear.  

 

 

 

Select “Activation Code” and press “OK” 
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Input your User ID and Activation Code provided by J&X Technologies or the 

authorized distributor, then Canvas will open. The code is valid for two years 

and can be extended for users who have purchased the software. 

 

If you do not have the activation code, please apply one for trial use via  

tangluxi@jnxtec.com 

 

  

mailto:tangluxi@jnxtec.com
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Chapter 2. Software Panel Layout 

 

As shown below, Canvas user interface is composed of several panels. All the 

panels can be opened or closed or moved to different positions by dragging the 

title bar of the panel. 

 

 

 

Menu and Tool Bar: various functional buttons 

2D View panel: display the current GC×GC chromatogram and color scale 

1D View panel: display the 1D Projection of the GC×GC chromatogram or the 

1D data of the selected modulation period (1D Spot View) 

Mass Spectrum panel: display the mass spectrum of the selected peak (only 

for MS data) 

Peak Table panel: display the information of all the identified peaks and 

matched clusters in the current GC×GC chromatogram and their quantification 

results 

Cluster Table panel: cluster creation and analysis for the current data 

Info View panel: show all the operation and information of the selected peak, 

and system log information if “Show Log Track” in Help is selected. This panel 

can be activated by hovering mouse cursor to the Info View tag on the right 

end of the interface. 
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The functions in these panels will be discussed below and in the subsequent 

chapters. 

 

Menu  

File 

[Load Data]: load GC×GC data files 

[Generate Report]: generate a report of the current analysis result 

[Export to CSV]: convert the current 2D chromatogram data to csv data 

[Save to 2D Library Image]: save the current 2D chromatogram to a 2D library 

image file 

[Exit]: exit Canvas 

 

Speciation 

[Find All Peaks]: automatic detection and integration of all the peaks in the 

current 2D chromatogram 

[Peak Table]: display Peak Table panel 

[Cluster Definition]: display Cluster Table panel 

 

Mass Spectrum 

[Extracted Spectrum View]: display the Extracted Spectrum View panel for MS 

data 

[MS Setting]: set parameters for MS data analysis 

[Library Search of All Species]: automatic library search of all species in the 

current chromatogram 

[Noise Filter]: set abundance threshold of the ion and filtered ions 

[Selected Ion Chromatogram]: set ions for the selected ion chromatogram  

[Extraction Rules]: set extraction rules for the extracted ion chromatogram 

[Resume TIC]: display TIC chromatogram 

[Deconvolution]: manual deconvolution functions for MS data 

 

 

Hint: Mass Spectrum functions are available only for MS data. 
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View 

Display or hind different panels for Info view; 1D spot view; 2D view. 

[3D View]: display a 3D surface plot for the current data 

[Compare View]: activate the chromatogram comparison between two data 

[Resume 1D Projection]: change the 1D Spot View to 1D Projection of the 

current data 

[Raw Pixel Mode]: remove smoothing and interpolation of the 2D chromatogram 

and show the original pixel points of the data  

 

Miscellaneous 

[Multi Sample]: add the analysis result of the current data to comparison 

[Batch Analysis]: load and process multiple data files in one time using the 

same cluster template and generate comparison results 

 

 

Help 

[License]: current license information 

[About]: current Canvas version 

[Show Log Track]: display system log information in the Info View panel 

  

Hint: Miscellaneous functions are active only when cluster template is 

saved and locked. 
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Chapter 3. Load Data 

 

Load a GC×GC sample data from “File → Load Data” in Menu bar  

or Tool bar    .  

 

Canvas can load a variety of GC or GC-MS data format, including: 

• Agilent (.D, .ch, .ms) 

• Shimadzu (.gcd, .qgd)  (must install GCMS-Solution or GC-Solution 

before installing Canvas) 

• Thermo (.raw) (must install Xcalibur before installing Canvas) 

• HeXin (.gcidx) 

• General data formats (.mzxml, .cdf, .csv ). 

 (CSV file must only include 2 comma-separated columns, column-1 being time 

in minute, column-2 being the signal. Other characters must be cleared.) 

 

When the data is selected, Data Setting window will appear. If the data file is 

loaded for the first time, the span time values are default, i.e., the start and end 

time of the original data. You can input any time within the span time of the 

original value to display a part of the chromatogram. For example, exclude the 

solvent peak, if there is any, by truncating the first few minutes. The span time 

value is stored and used when the same file is loaded in a later time. Double-

click in the start or end time cell will return to the default values. 

 

Hint: If the data format is not listed above, they need to be converted to 

one of the above general data formats, e.g., .csv; .cdf; .mzxm. 

 

Hint: Truncating at different initial time will change the noise level, thus 

slightly affecting the peak speciation results. 
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If “Follow last figure setting” is checked, the chromatogram is displayed with 

the same image parameters as the preciously loaded data (color map, SNR, 

period, 2D shift, see Image Setting). 

 

In the Notes shows the filtering and minimum abundance information used in 

last time the data file is loaded. These information is stored and applied until 

new parameters are manually set in “Mass spectrum→ Noise Filter” (See MS 

Data Processing).  

 

Press OK in the Data Setting window, displays the GC×GC chromatogram and 

the its 1D projection, which is made by summing all the signals in every 

modulation period. Canvas will automatically calculate the modulation period of 

the data and apply to generate the 2D chromatogram (except Follow last 

figure setting is checked and the period of the last data file will be used). 

However, if the calculated period is wrong, the correct modulation period should 

be input manually. If Canvas cannot calculate the modulation period, it will 

display as a 1D GC chromatogram with the modulation period set to 0. Input 

the correct modulation period by pressing   to display the corresponding 

GC×GC chromatogram.  
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Information of the data will be shown in the Info View panel, such as start and 

end times (original), acquisition rate, total run time, and modulation period.  
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Chapter 4. Image Setting 

 

The 2D chromatogram can be zoomed in by simultaneously pressing 

and dragging the mouse in the plot area. Press and holding the 

mouse left button (or use the mouse wheel) to move the enlarged plot, Undo 

the last zoom and reset to the default plot can be accomplished by right clicking 

the mouse in the plot area and selecting the corresponding operation.  

 

The main functions for image, mark and text can be found in the Tool Bar. 

 

 

Color Map:  

Depending on the different mapping scheme of peak signal to color, Canvas 

provides four Color Maps: Scent, Flame, Fluorescence, and Graphite. 

 

 

Alt 

Ctr
l 
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SNR: The lowest signal-to-noise value of a peak that can be distinguished in 

the GC×GC chromatogram  

 

Period: modulation period of the GC×GC chromatogram, in second, need 

manual correction if wrong 

 

2D Shift: move the 2D chromatogram in the second dimension by changing the 

initial time to convert the 1D raw data to GC×GC data, in second. We suggest 

using the 2D shift that reflects the actual elution order in the second dimension, 

i.e., the early eluters at the bottom of the 2D chromatogram and the late eluters 

at the top. Below shows the result of changing the 2D shift from 0s to -3.00s 

and reflects the actual elution order with the minimal wraparounds. Canvas will 

automatically detect the GC×GC chromatogram and set a default 2D shift value, 

which can be changed manually.  

 

Every time the above image parameters (Color Map, SNR, Period, 2D shift) 

are changed, the image needs to be refreshed using .  

 

Font: change the font size of the text labels in the 2D plot 

Mark: change the dot size of the peak mark in the 2D plot (for bubble mark, it 

refers to the largest size of the bubble) 

Hint: When the 2D shift is changed, the 2D retention time (RT2) of each 

peak will change too. Speciation again to get updated RT2. 

  

                    2D Shift = 0 s                                                                 2D Shift = -3.00 s 
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Mark Type: select Dot (red circle with the same size) or Bubble (size 

dependent on peak signal) 

 

Generally, the peak in the GC×GC chromatogram is subject to mathematical 

smoothing and interpolation for better appearance. When Raw Pixel Mode is 

selected in “View → Raw Pixel Mode”, the data is displayed without any 

smoothing or interpolation and the original data point is stacked as pixels in the 

chromatogram. 

 

Raw Pixel Mode 

 

Normal (Smooth) Mode 

 

 

3D View 

A 3D surface plot will be displayed for the current data by selecting “View → 

3D View”.  
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Left click the mouse to move the image, right click to rotate the image, and roll 

the mouse wheel to zoom in or zoom out. The X, Y, Z scales can be adjusted 

independently with the corresponding sliders. The 3D surface plot can be saved 

as an image file. 
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Chapter 5. Speciation 

 

Select “Speciation → Find All Peaks” in Menu  

or Find All Peaks    in the Tool Bar for peak analysis. 

 

Exception View window will appear. 

 

 

 

Signal/Noise Ratio: specify a S/N threshold below which peaks are not 

detected and integrated 

Noise: previously calculated noise level of the data, first-time loaded data will 

not show noise value 

Manual Peak Widths: when checked, manually input the estimated peak 

widths for each of the 11 equally spaced segments in the chromatogram, only 

active for data that has been analyzed previously; peak width values are 

measured in number of sampling data point  

High Sensitivity Peak Merging: select to aggressively distinguish co-eluted 

species in the GC×GC chromatogram, for poorly resolved separation in the first 
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dimension; use with caution since it will cause incorrect peak slice spitting that 

should be combined. 

Bleeding Peaks Auto Removal: select to remove non-essential peaks such 

as column bleeding and streaks from the same compound for integration; use 

with caution since it will remove some valid peaks that are placed closely and 

continuously with each other. 

 

Exception table: display retention times or retention time windows that manual 

integration takes effect; entries are added only by Manually Integrate (see this 

Chapter “Manual Integration”) but can be deleted here. 

 

Initial Tolerance for Adaptive Cluster Matching is only available when 

cluster template is created. It determines the errors for retention time matching 

when applying cluster template to a new data. See Cluster Analysis for details. 

 

Click OK and Canvas will automatically conduct peak detection, slice merge, 

and integration. All the detected and merged peaks will be marked as Dot or 

Bubble in the GC×GC chromatogram. You can change the mark size and text 

font size in the Tool Bar. 
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The peak summary will be displayed in the Info View window, and all the peak 

information, such as RT1, RT2, peak area, peak percentage, peak width, etc., 

are listed in Peak Record table (“Speciation → Peak Table” to open). 

 

       

 

You can choose to display or hide the information of the Peak Record by right 

clicking on the title row on the table.  

 

Peak Label Setting and Compound Locking 

When the Spot View Switch  is on, peak or compound can be selected in 

the Peak Record table or in the 2D View plot. Selected species are labelled in 

the plot as the compound name or compound number (when compound name 

is blank) and highlighted in the Peak Record. The color of the label and text is 

designated when the Spot View Switch is activated. Click the selected species 

again to deselect. Disable Spot View Switch first when change the label color. 
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Labels/Compound name can be renamed by right clicking on the peak and 

selecting “Rename Label”. Input a new name and this name will be copied in 

the Peak Table. Select Move Label Text after right clicking in the 2D View plot, 

and all the label texts can be moved. The 2D View is now at editable mode. 

Select Move Label Text again to exit the editable mode. You can also copy the 

name to the Peak Record by right clicking the matched compound name in the 

Extracted Spectrum View (see MS Data Processing). With the above two 

methods, the compound is locked/specified in the Peak Record and shown in 

red. Library Search for All Species will match all the compounds in the Peak 

Record and assign a matched compound name to each species. In this way, 

the compound name is not locked and shown in black.  

 

When Library Search for All Species is performed, Canvas will ask if the 

specified compounds should still be locked. Select “Yes” and these compound 

names will not change during the library search; otherwise these names will be 

replaced by the matched compounds. 

 

When the Spot View Switch is off, select one or more labelled or locked peaks 

in the Peak Record, right click and select to remove the labels or disable the 

locking. 

 

Peak Table Operation 
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Load Labels: open a saved peak record affiliated with the current data and 

reload all the labels 

Save: save the current peak table affiliated with the current data with the labels 

Save as Text File: export the peak record to a .txt file 

Label with Numbers: label all the selected peaks with designated numbers; 

the number and their compound names can be found in Info View.  

Sort by Label Color: sort peaks according to their label color 

Duplicate: If compound name has duplicate in the Peak Record, show 1 in the 

Duplicate column; otherwise show 0 

 

Matched Cluster Result will be discussed in Cluster Analysis 

 

Speciation Interaction 

Some interactions with speciation results in the chromatogram are available 

on the Tool Bar. 

 

 

 

Click Spot View Switch  to activate Spot View function.  

 

Select the peak mark on the 2D View or in the Peak Record table and 

designate a label color for each species, which has been discussed previously. 

Here the details of the peak slice component and integration results will be 

discussed.  

 

Either a peak on the 2D View plot or a compound in the Peak Record table is 

selected with the Spot View Switch on, the original 1D chromatogram in one 

modulation period of the main slice of the selected peak will be displayed in the 

Spot View window (1D view). A small arrow shows the selected peak; the 
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number above each peak is its peak number in the Peak Record. The different 

colors in the 1D chromatogram represents different species identified and their 

integration profiles, together with chromatograms in the previous (dash line) 

and next modulation period (grey line). Detailed peak integration results show 

in the Info View, including slice number and the peak area of each slice. 

 

 

 

The 1D Spot View plot of the previous and next modulation period can be 

shown by clicking Previous Period and Next Period  in Tool Bar.  

 

Same as the 2D plot, the 1D plot can also be zoomed in or zoomed out and 

saved as an image file using the same method. In addition, “Measure Base 

Peak Width” function is available by right clicking on the 1D Spot View plot. It 

requires a 1st click in front of a speciated 1D peak and a 2nd click after the peak 

to measure its peak width, in number of the sampling point, as well as the time 

segment the peak is located. When choose “Save for Speciation”, the peak 

width value of the segment will be copied to the Exception View window (see 

Manual Peak Widths in this Chapter). Perform Speciation will use the new 

peak width. 
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If the data contains MS information, the mass spectrum is shown in the 

Extracted Spectrum View and the matched compound spectrum in the library, 

if the library is correctly installed and set in MS Setting. 

 

 

 

Blue spectrum is the target mass spectrum, while the red one is the matched 

spectrum, with the identified compound information shown below.  

 

Select other compounds with lower match factors in the drop-down list of the 

compound cell; the number of the matched compounds can be set in MS 

setting. Right click the compound name will copy it to the Peak Record table 

Hint: “View → Resume 1D Projection” will return to the 1D Projection 

chromatogram of the data. 
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and lock the compound. Other functions will be discussed in MS Data 

Processing. 

 

Mark switch  is used to display or hide the peak mark (Dot or Bubble) in 

the 2D View plot.  

 

Manual Integration 

In addition to automatic peak integration and merging, manual integration can 

be employed. This function is activated after Speciation is completed. 

 

 

  
Integrate on 1D View includes Set 1D Shoulder and Set 1D Merge, both of 

which require operations in the 1D Spot View. 

 

Set 1D Shoulder: require in 1D Spot View window a 1st click at a start time 

and a 2nd click at an end time; within the window the default drop-line division 

will change to tangent-skim 1D shoulder 

 

Set 1D Merge: merge multiple consecutive peaks in the same modulation 

period, require in 1D Spot View window a 1st click on a start time and a 2nd click 

on an end time; peaks within the window will be merged. 

 

For example, in the following chromatogram, the peak 55,52,56,54 need to be 

merged as one peak. After selecting Set 1D Merge, first click at the start time 

and second click at the end time. The four peaks are now merged as one.  
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The manual integration event is now recorded in the Exception View window 

as below, using “Speciation → Find All Peaks”. This merge operation can be 

deleted only in the Exception View window. 

 

 

 

Integrate on 2D View includes Set 2D Merge and Set 2D Split, both of which 

require operations in the 2D View. 

 

  

                      Before merge                                                         After merge 
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Set 2D Merge: merge multiple peaks in different modulation periods, click on 

peaks to be merged one-by-one, and finish by pressing 

 

For example, in the following chromatogram, peak 1 and 2 should be merged.  

 

 

 

Select Set 2D Merge and click on the two peaks in the 2D chromatogram. Press  

to complete the 2D merge. The two peaks are now merged as two 

slices of the peak, and the event is recorded in the Exception View window. 

 

 

 

Set 2D Split: split the merged peak. This is the reverse operation of the above 

Set 2D Merge. Turn on Show Peak Outline on the Tool Bar, select a peak to 

be split, then click on a slice, and all the slices on the right (including this slice) 

will be split from the original peak.  

 

 

 

Space 

Space 



J&X Technologies 

25 
 
 

When a peak is selected, the slices outline will be shown in yellow box. In the 

chromatogram below, the selected peak has four peak slices. If, the last slice 

needs to split from the peak and merged into the next peak, first select Set 2D 

Split and select the target peak to show the outlines, click the last slice to split 

it from the original peak. This slice is now a separate peak. Next, merge this 

peak into the next peak using Set 2D Merge as described above. 
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Chapter 6. Cluster Analysis 

 

Cluster is a group of multiple peaks that can be analyzed collectively. Cluster 

analysis, commonly used in GC×GC data processing, takes advantage of 2D 

space and highly structured distribution of species in GC×GC chromatogram.  

  

Select “Speciation → Cluster Definition” to activate Cluster window. 

 

 

 

 

In Canvas, clusters are saved as a template, which includes multiple clusters 

with various types. The saved template can not only be used in the current data, 

but also shared for other data. Some of the important cluster operations in the 

Cluster Tool Bar are shown below. 
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Cluster Loading, Creating, Deleting, and Saving 

Clusters can be classified as area cluster and point cluster, corresponding to 

different match criteria.  

 

⚫ Area cluster: consists of all the peaks inside a designated closed polygon 

area in 2D View plot, identified peaks within the polygon boundary being 

matched after speciation. 

 

⚫ Point cluster: consists of multiple individual peaks in 2D View plot, identified 

peaks with the same 1D and 2D retention times being matched after 

speciation. 

 

There are two ways to create a cluster in Canvas: Draw a Polygon and Select 

Target Points.  

 

 

 

After selecting Draw a Polygon under Create button  in Cluster Tool Bar, 

you can create either an area cluster or a point cluster. The 2D View becomes 

editable. Use the mouse left button to select in sequence the endpoints of the 

polygon and press to finish and close the polygon. Use                               

to cancel a previously selected point. 

 

If an Area Cluster is selected, the polygon boundary is displayed. When this 

template is used to match new data, all the identified peaks within the boundary 

is matched and included in the cluster. 

Space 

Esc 
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If a Point Cluster is created, all the identified peaks within the polygon 

boundary is displayed in triangles. The 1D and 2D retention times of these 

peaks are used for matching new data. 

 

 

 

After clicking Select Target Points under Create button  in the Cluster Tool 

Bar, you can choose to Pinpoint in 2D View or Insert from the Peak Table. 

When Pinpoint in 2D View is selected, the 2D View becomes editable, then 

manually pinpoint (left click) target peaks in the 2D plot, press   

to end. Click a selected point will deselect this point. When Insert from Peak 

Table is used, select compounds in the Peak Record table in sequence, and 

press Add, after select the last compounds, press Add End to finish. Also, 

multiple compounds can be selected at once by moving the mouse down to 

include consecutive compounds in Peak Record table. 

 

 

Space 
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Cluster name can be manually edited by double clicking the corresponding 

name cell.  

 

The individual peaks in a point cluster are shown in the Cluster Compound 

Table below the Cluster Table and their names are editable. The compound 

name can also be copied from the Peak Record table (right click on the 

compound name). Right click the name column to add or remove any 

component in the Cluster Compound Table. 

 

Each cluster can be characterized as different types in the Type column. The 

two universal types are 

• Target: species to be analyzed in a sample and quantitated. They will 

be displayed in the Peak Record table and Matched Cluster Result 

after template application. 

• Exclude: species to be excluded from analysis and report, e.g., those 

associated with column bleeding or solvent peaks. These peaks will not 

be shown in the Peak Record table and Matched Cluster Result. 

 

For aera cluster, there is one special type. 

• Hump: regular speciation of individual peaks is not performed inside this 

area. The quantitation is conducted by integrating all the signals above 

the baseline in the polygon area, suitable for complex samples in which 

compounds are not well separated. 

 

For point cluster, there are two special types. 

• RI: a group of species with user-specified linear Retention Indices (RIs) 

for automatic calculating RIs of other species 

Hint: A better way to select multiple peaks from the Peak Record table is to 

label the target peaks with the same color, after Sort by Label Color, these 

peaks can be selected all at one time. 
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• 2D-Shift-Ref: a group of species that may be present in all samples and 

used to calculate a 2D shift for best peak alignment with a template 

 

A cluster can be shown or hidden in the 2D View plot. If Show is selected in 

Mark column, the boundary of an area cluster or all the peaks of a point cluster 

is highlighted. If HideAll is selected, all the cluster marks are removed. If 

HidePeak is selected, only peak names of point clusters are removed but 

cluster names are remained. 

 

Save the cluster as a local or shared template using . The local template is 

used only in the current data and stored in the local data folder. The shared 

template can be used for other data and is stored in a designated directory. 

Shared templates can be used in the current data by Import Template  in 

the Cluster Tool Bar.  

 

When Lock Template File for New Data is checked, the current template will 

become the shared template, and newly loaded data will be processed by this 

template after speciation. Under this “Lock Template” mode, “Save to Local 

Template” will become “Save Locked Template”. 

 

A cluster can be deleted by pressing the Delete button  in the Cluster Tool 

Bar.  

 

After all the clusters are defined and saved, a new speciation needs to be 

conducted to apply the template to the current data. If the clusters in the 

template matches the current data point, i.e., peaks are found in the defined 

cluster according to the polygon boundary, the 1D and 2D retention times, or 

the selected ion if any, clusters will be shown in bold.  

 

Hint: Template must be saved before applying it with speciation. 
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The quantitation results of a Target- or Hump-type cluster (such as the matched 

peak areas and percentages) will be shown in the Matched Cluster Results 

after template is applied.  

 

If template fails to match the peaks in the current data due to shifted secondary 

retention time, change the 2D shift value and redo speciation for better match. 

Iteration of 2D shift may be needed for optimized match. A better approach is 

to use 2D-Shift Ref cluster (see below).   

 

Match the template 

By default, the template match is based on retention times in the chromatogram. 

For area cluster, it is the retention times of the polygon boundary; for point 

cluster, it is the 1D and 2D retention times of the individual peaks.  

 

The template matching tolerance parameters can be set up in the Exception 

View window when template is created. For 1D, unit is the number of 

modulation period; and for 2D, unit is second. It only specifies RT tolerance for 

matching early eluting species; late eluting species are matched at projected 

retention times based on the trend of RT shift between species within a cluster. 
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For MS data, information of extracted ions can be used for template match. The 

extraction rules for area cluster is listed below the Cluster Table; while that for 

point cluster is shown in an extra column in the Cluster Compound Table. 

Double click the extraction rules cell will prompt the Ion Extract Editor (see 

MS Data Processing). Only the peaks that meet the extraction rules can be 

eventually matched in the template. 

 

 

 

Retention Index 

A RI cluster is a point cluster that consists of species with user-defined linear 

retention index (LRI or RI), usually a series of n-alkanes, whose RIs are defined 

as the carbon number multiplied by 100. When a RI Cluster is defined, the RI 

values should be input in the Cluster Compound Table for each species. If a 

series of n-alkanes is used, auto-filling can be used. Click the title of RI 

Reference of a RI cluster, in the Cluster Compound Table, and input the 

carbon number of the first n-alkane and the carbon number interval for the 

series, Canvas will automatically enter the n-alkane name (shown as Cn, with 

n the carbon number) and their retention index (RI) in the table. 
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When the templated is applied after speciation, the RI values for all the 

identified species in the current 2D chromatogram will be calculated in the Peak 

Record table. 

 

2D-Shift Ref 

A 2D-Shift Ref cluster is used to calibrate the 2D shift for different data files so 

that the same compounds have the same 2D retention times. Usually it consists 

of a few standard compounds that are present in most of the samples. We 

suggest select more than 4 compounds which have substantial intensity in the 

chromatogram in order to get better result. This cluster should be saved as a 

Shared Template for calibration of other data, or under Lock Template mode. 

When a 2D-Shfit Ref cluster is imported into a new sample, which contains most 

of the species in the cluster, click Auto 2D Shift  in the Cluster Tool Bar will 

set a new 2D shift for optimal match of these compounds in the secondary 

dimension. 

 

If there is a growing trend of retention time shift with elution order between 

samples, 2D shift alone may eventually fail to compensate for both the early 

and late eluters in the sample. To adapt to such a trend, users may click Update 

Hint: Only one RI Cluster is allowed in a Template. 

Hint: Only one 2D-Shift Ref Cluster is allowed in a Template. 
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RTs button   to update retention times of the compounds in the template 

while data can still be matched but deviation is apparent. 

 

Cluster Modification 

Activate Move Cluster  in the Cluster Tool Bar, the 2D View becomes 

editable, then select any endpoint of the area cluster and change its position, 

the boundary of the area cluster will be changed. For point cluster, any point 

(target peak) position can also be moved by the same way. Click Move Cluster 

 again to disable this function. Remember to apply speciation for new 

template match. 

 

The area cluster can be split from designated 1D retention times. Click Split 

Cluster  and select the split position (1D time) in the 2D View. Multiple 

positions can be selected. Use  to undo the last position selection and 

press  to finish. All the shown area clusters (except the Exclude-type 

cluster) will split to several small area clusters according to the 1D split times 

at the selected positions. The original cluster will also remain. 

 

 

 

Generally, if the 2D shift value is changed after clusters are created, the 

positions of the clusters will not shift, and the original template match will be 

lost due to the 2D shift. In order to move all the clusters in the template the 

same value as the 2D shift, check Sync with 2D Shift under the Cluster 

Compound Table. In this way, clusters in the template will shift together with 

the data and the template match will not be affected. 

Esc 



J&X Technologies 

35 
 
 

 

Lock Template 

If the same cluster analysis procedure is needed for a series of data files, such 

as standard calibration curve (see Quantitation Methods), check Lock 

Template File for New Data after template is created and saved. The template 

file name will be highlighted in yellow at the bottom. All the loaded data files 

afterwards will implement the same template, until it is unchecked. 

 

 

 

EIC Quantify 

Quantitative analyses can be done with Target- and Hump-type clusters. For 

MS data if EIC instead of TIC is used for quantitation, check Use EIC to 

Quantify below the Cluster Compound Table. An extra column of Quant Ion 

will appear. For point cluster, each compound will have a quant ion; while for 

area cluster, it has only one quant ion for the cluster. The quant ion can be input 

manually or automatically (see below). 

 

In EIC Quantify mode, Set Quant Ion  and Extract Qual Ions  tools in 

the Cluster Tool Bar are enabled. These two functions are for point clusters 

only.  If they are selected (and template is saved and speciation is conducted), 
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the most abundant ions of each compound will be set in Quant Ion column (Set 

Quant Ion), and extraction rules of the next two most abundant ions (as 

qualifier ions) will be set in the Extraction Rules column for all the compounds 

in the point clusters (Extract Qual Ions). 
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Chapter 7. MS Data Processing 

 

When MS data file is loaded (.ms; .qgd; .raw; etc.), Canvas will proceed the MS 

data by default as TIC for 1D and 2D chromatograms and peak integration.   

 

Mass Spectrum will be activated on the Menu. The functions in this menu are 

discussed below. 

 

Extracted Spectrum View 

It displays the mass spectrum of the selected peak (blue), from the 2D View or 

from the Peak Record table with the Spot View function on. The decimal digits 

of m/z can be set in MS Setting (for unit mass resolution MS data, use 0). If a 

MS library is installed and its directory is corrected designated, the best 

matched compound spectrum is shown (red). The matched compound is listed 

in the Matched Compound Table below.  

 

 

 

Matched Compound 

The Matched Compound Table lists the information of the compound with the 

highest match factor, such as compound name, chemical formula, CAS #, 

forward and reverse match factors, molecular weight, etc. Select more match 

options in the drop-down arrow. Right click on the compound cell to import the 

name to the Peak Record table, and to lock the compound so it can be 

remained after an automatic library search. 
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NIST Library 

If a NIST Library is installed, double click the mass spectrum area opens the 

NIST Library program with the detailed match information.  

 

If the NIST Library program does not appear, the reasons could be one of the 

following. 

1. No AMDIS files in the NIST directory 

2. Library Search Options does not include any valid libraries in the NIST 

Library program 

3. NIST is installed under Program Files, with no write permission 

 

Spectrum Data 

Click Spectrum Data  on the top of the Extracted Spectrum View, shows 

the detail information of the spectrum. 

 

For high resolution MS data, formula can be deduced based on exact mass.  

Select a target ion from the left ion list, its exact mass will be copied to the 

formula finder program on the right; input a mass tolerance and select elements, 

possible formula can be calculated. In addition, you can select one or multiple 

ions in the left table, right click and choose Calculate, the formulas are 

calculated and shown in the table. Click on the title of Intensity, the ions will sort 

as their absolute intensity values. 

 

 

Hint: NIST Library should be installed and correctly set. 



J&X Technologies 

39 
 
 

 

Show List 

Select Show List  on the Tool Bar of the Extracted Spectrum View, the 

matched compounds will be displayed in the list under the spectrum, in order 

of their match factors. The number of the shown compounds is designated in 

MS Setting. Click Show List  again to show only one compound in the table. 

 

Background Subtract 

Click Background Subtract  on the top of the Extracted Spectrum View, 

to activate the Background Subtract View on the right. The spectrum of the 

target peak is displayed in blue.  Select the background in the 1D Spot View, 

the background spectrum will appear in the Background Subtract View in red 

under the target spectrum. Press the Subtract Button to conduct subtraction, 

and the target spectrum and match results will be updated. 

 

 

 

MS Setting 

MS analysis parameters are set in “Mass Spectrum → MS Setting”. 

 

Library Setting 

In the Library Setting Window, select the library path, usually a NIST 

MSSEARCH file. We suggest use NIST14 and newer versions for best match. 

Below the path, on the left shows all the available libraries. The library \mainlib 
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should be first added to the right. If retention index is used to assist library match, 

\nist_ri should be added too. You can also add other libraries if it follows NIST 

library protocols. 

 

 

 

RI Setting 

Retention index can correct and improve the library match results. When a 

template including a RI cluster is imported or created, Canvas will calculate the 

retention index (RI) of each identified peak, which compare with the RIs of the 

matched compounds in the selected library (\nist_ri). If significant deviation is 

found for the calculated and library RIs, a penalty score is applied in the match 

factor, thus affecting the final match result. Select RI Setting panel in the 

Library Setting window to set parameters for RI assistant library match. 
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Check Use Retention Index (RI) Comparison for Library Search Match 

Factor Correction to enable RI assisted library match. Canvas only consider 

the 1D retention index for GC×GC analysis. First select a 1D column, then 

check the column options below accordingly. Use a RI tolerance for 

comparison (should be positive), typically 10-50. RI penalty rate determines the 

degree of the library match correction based on RI comparison result. We 

suggest Strong or Very Strong.  

 

MS Global Setting 

Set other MS parameters in MS Global Setting. 

 

 

 

Input the Number of Matched Compounds shown in the Extracted Spectrum 

View (maximum number of 100) and the Decimal Digits for m/z of the 

spectrum (for high resolution MS data). For regular NIST library search, only 

unit mass resolution is used. High resolution MS data need to convert to unit 

mass resolution by either taking the most abundant ion in the range of one unit 

mass and discarding all other ions in this range (Use the Max Ion) or summing 

all the ions intensities in the unit mass range (Sum All Ions). HiRes Global 

Precision, set in unit of ppm, determines all the tolerance in high resolution MS 

data analysis. 
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If Auto Background Subtract is checked, Canvas will automatically find the 

edge of each peak, subtract the background at the peak edge, and display the 

subtracted spectrum. The library search will be conducted according to the 

subtracted spectrum. 

 

Library Search of All Species 

“Mass Spectrum → Library Search of All Species” enables automated 

search of all the identified peaks in the 2D chromatogram for the best matched 

compounds, and the compound names will be shown in the Peak Record table. 

You can choose to remain the names of the locked compounds when 

performing the library search. 

 

Noise Filter 

The minimum abundance of the ion signal can be set to reduce the background 

level. Any ion signal less than the threshold will be set as zero. Additionally, 

specific ion or ions can be removed from the data and will not be displayed in 

the chromatogram. The Minimum Abundance and/or Filter Out Ions 

parameters will be stored and apply to the same data when it is loaded later. 

The parameters will be shown in the Data Setting window when it is loaded. 
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Select Ion Chromatogram 

Besides TIC, EIC can be shown by selecting “Mass Spectrum → Select Ion 

Chromatogram” and entering the ion or ions to display.  

 

For unit mass resolution MS data, the default width is 1.0 (± 0.5 amu). For high 

resolution MS data, the width can be manually input, in unit of ppm. 

 

 

 

Click OK and the EIC chromatogram will be displayed. Check Lock TIC as 

Background to maintain the TIC as gray background for better comparison. 

 

 

 

 

Hint: Lock TIC as Background is only available for Scent color map. 
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The selected ion or ions will be stored in the record, under the folder named by 

the mass width (always 1.0 for unit mass resolution ions). The records can be 

imported for new data when needed. 

 

Extract Rules 

Computer scripts can be used to construct advanced logic rules to screen target 

compounds from TIC chromatogram.  

 

 

 

Four functions are available 

ABUND(X): input ion mass X, return its normalized abundance (max 100) 

HASMASS(X): input ion mass X, return 1 if the spectrum has this ion, return 0 

if the spectrum doesn’t have this ion 

ORDER(X): input ion mass X, return its abundance order (>0) 

MASS(X): input abundance order (>0), return the ion mass of that order 

 

 

In addition, “And (&&)” and “Or (||)” logic functions can be used in the extract 

rules to combine different functions. Common operational symbols, such as +, 

Hint: Extract Rules only supports unit mass resolution. 
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-, (), >, <, =, are also supported. The priority of these operations is below, from 

high to low. 

1. () 

2. +, - 

3. <, >, = 

4. &&, || 

 

Select the correct function from the Function List and input the X value, add 

operational symbols if necessary, click Extract, the EIC chromatogram will be 

displayed in the 2D View. 

 

Some of the examples of the extracted functions are shown below. 

1：76 is the second most abundant ion mass in the target species  

 ABUND(76)>0 && ORDER(76)=2 

2：species that have ions with mass of either 76 or 131  

 ABUND(76)>0 || ABUND(131)>0 

3：species have ions with mass of 161 whose abundance is greater than 50 

ABUND(161)>50 

4：55 is most abundant ion mass and 161 is in top 3 most abundant ions 

MASS(1)=55 && ORDER(161)<4 

 

When the script for extracting ions are written, click arrow  to save the script 

to an ion extract file to the right. If the script needs to be used for a new data, 

select the file and click   to load the script to the left editor for ion extraction. 

 

The extract rules can also be used for template match.  Double click the 

Extraction Rules for point or area clusters to edit the script (see Cluster 

Analysis).  

 

Resume TIC 

2D View will resume the TIC chromatogram of the current data. 
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Deconvolution 

Mass spectral deconvolution is a mathematical algorithm designed to extract a 

signal from a complicated (coeluted) mixture based on elution patterns of 

different ions. Canvas provides simple manual deconvolution function to 

remove interfering ions and extract a pure mass spectrum of a compound, or 

separating different components in one peak, thus improving identification 

accuracy.  

 

After speciation, select a peak (with potential coelution or interference) with 

Spot View Switch on, click “Mass Spectrum → Deconvolution”, an additional 

window appears on the 2D View.  

    

 

Input a Relative Threshold value (relative to the most abundant ion), and 

Canvas will generate chromatograms of each ion greater than the threshold. 

Use an appropriate Relative Threshold value so that 10-20 ions are included.  

 

Click Load Target  , and the chromatogram of each ion within the 

modulation period of the main slice of the peak will be shown. Black vertical 

lines represent the peak edge. Up to 8 ion chromatograms are shown in one 

plot in which each color represents one ion. Double click one plot will show only 

this plot; double click again will show all the plots.  
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Canvas will determine if there are any impure ions based on the one-

modulation-period chromatograms of different ions of the peak and display in 

the Info View. 

 

  

 

Click Execute Deconvolution  to remove these impure ions from the mass 

spectrum of the peak, or group different ions for species, and perform the new 

library search for the major species. The library match result is updated. 

 

In addition, ions can be manually removed by checking Remove Ion and 

selecting corresponding ion chromatograms in the plot. Use  to undo the 

last remove action. When remove is finished, click  to perform a new library 

search.  
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Finally click  to present the deconvolution result of the chromatograms of the 

separated species (by their main ions), as well as the m/z of all the extracted 

ions in these species.   

 

 

  



J&X Technologies 

49 
 
 

Chapter 8. Quantitation Methods 

 

Three quantitation methods are available in Canvas. 

• Peak Area Percentage 

• External Standard (ESTD) 

• Internal Standard (ISTD) 

 

Peak Area Percentage 

Peak area and their percentages are calculated and demonstrated in the Peak 

Record panel, after Speciation is completed. Peak area is the sum of areas of 

all the slices comprising the peak. The percentage is the ratio of the peak area 

to the total area of all the identified peaks, not including peaks matched in the 

Exclude-type clusters.  

 

  

 

After template is applied, the Matched Cluster Result panel shows the 

quantitation results of the all the target-type and hump-type clusters, including 

peak area and normalized percentage. For area clusters, only the sum of all the 

matched peaks is calculated; for point clusters, the peak area and percentage 

of each compound in the cluster are listed.  
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Select Area Percentage  in the Matched Cluster Result Tool Bar, and 

Canvas shows the number of components and the peak area percentage of all 

the clusters. Click Time Divided Area Percentage  and input a divided 1D 

time, and Canvas calculates the area percentages of all the clusters before and 

after the divided time. 

 

 

 

If in a template, one cluster is a reference with a known concentration, the 

concentrations of all the other clusters can be normalized based on the ratio of 

the peak area of the reference cluster and other clusters, assuming they all 

have the same response factor. Click Normalization , select reference 

cluster (only one) and target clusters (can be more than one). 

 

 

 

When a known reference cluster concentration is entered, the concentrations 

of all the selected unknown clusters (target) will be normalized. For area 
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clusters, it calculates the total concentration of all the peaks in the area; for 

point clusters, it calculates the concentration of every compound. 

 

 

 

Al the above results can be exported and saved as text files (.txt). 

 

External Standard (ESTD) 

External Standard method employs a series of standard samples with different 

concentration levels to create a calibration curve, relating the concentration to 

the peak area of a target compound. The calibration curve is then employed to 

calculate the concentration of the compound in an unknown sample.  

 

All the standard and sample data should be analyzed under the same 

speciation conditions and template, with Lock Template File for New Data 

checked. A standard cluster should be created containing all the standard 

compounds.  

 

First load a standard data, after speciation, click Calibration  in Cluster 

Tool Bar to activate Calibration Curve Editor window. 

Hint: All the standard data must be analyzed under Lock Template mode. 
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Input Concentration and Unit of this level, then Add the current data into the 

calibration curve. All the standard compounds or clusters are listed in the left 

Standard Table. Each standard is designated with a Cluster ID and Peak ID. 

The input concentration applies to every standard compound in a point cluster, 

or the total concentration of all the peaks in an area cluster. When a standard 

is selected in the Standard Table, its calibration curve and quantitation 

information will be shown in the right Calibration Table. You can change the 

individual standard concentration in the Calibration Table. Click OK to finish.  
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Back to the Cluster Table, save the template, then load the next standard data 

with a different concentration level. Repeat the above procedure to add a 

second concentration level standard data to the Calibration Table. 

 

If a blank sample is included as a background which should be subtracted from 

other standards or samples, the blank data should be added with Add as Blank 

checked. The current peak areas of these compounds will be shown in the 

Blank column, which will be subtracted from all the other standard 

concentration or samples to complete the quantitation. 

 

After all the standard sample data have been analyzed and added into the 

Calibration Table, a calibration curve is created with the mathematical 

equation shown below the curve.  

 

 

 

Then, load an unknown sample data, still under the Lock Template mode, do 

the speciation to apply the template and the quantitation results will be shown 

in Matched Cluster Results panel. 

 

Internal Standard (ISTD) 

Internal Standard method is the same as External Standard method except that 

it adds an internal standard in all the standards as well as unknown samples, 

in order to minimize errors from sample preparation and injection.  
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During data analysis, the internal standard should be included in the same 

cluster as all the external standards that reference this internal standard. The 

ratios of the peak areas of the standard to the internal standard and the ratios 

of the concentrations of the standard to the internal standard are used to 

generate a calibration curve. 

 

In the Standard Table, the internal standard in a point cluster should be 

checked as ISTD and its concentration should be manually input in the 

Calibration Table for every concentration level (usually the same). For area 

cluster, a compound in another point cluster can be designated as its internal 

standard. Select in the ISTD box of the area cluster the Cluster ID of the point 

cluster, where this internal standard belongs. The rest operations are the same 

as ESTD method. 

 

 

 

Manual Integration of the Standard Compounds in Calibration Curve 

Canvas allows manual integration of the standard compounds when making the 

calibration curve in case the automatic integration is wrong, e.g., baseline or 

slice appointment errors.  
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Double click a Curve File in the Calibration Table on the right for each 

compound in the left Standard Table and below shows the 1D and 2D 

chromatograms of the peak at this concentration level. The 1D chromatogram 

covers one modulation period in which the main slice is located. The slice 

outlines of the target peak are shown in the 2D chromatogram as yellow boxes. 

 

 

 

Use  to check the previous and next modulation period for the adjacent 

slices of the peak. In the 2D chromatogram, input the X Axis Range (in unit of 

modulation number) and SNR value (show all the peaks above this SNR value), 

then click  to refresh. Examine the baseline position in the 1D chromatogram 

and slice merge in the 2D chromatogram. If modification is needed, select , 

and drag a new baseline using the mouse in the 1D chromatogram. Also, a 

slice in the 2D chromatogram can be deleted using   if it belongs to another 

peak. After these manual integrations, new peak area will be calculated, and 

the calibration curve will be updated.  
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Chapter 9. Chromatogram Comparison 

 

When a GC×GC data is loaded, the chromatogram can be compared with 

another data using “View → Compare View” in Menu to activate Compare 

View panel. 

 

 

 

Click Load Target to load another data file (Target File) for comparison with 

the original data (Original File). If the run time of the target is different from the 

original file, the target data will truncate (longer than original) or leave blank 

(shorter than original) to fit the original run time. 

 

 

 

Hint: The target data and the original data must have the same modulation 

period to be compared. 
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Set Relative 2D Shift value of the target (lower plot) and original (upper plot) 

data so the same compound appears at the same 2D retention time. Select a 

propriate SNR Ratio to better compare two data with different concentrations 

(using >1 if target data has greater concentration than the original data to 

increase the SNR threshold; while using <1 if less to decrease the SNR 

threshold). 

 

Left click on the original 2D chromatogram shows the 1D chromatogram within 

one modulation period of both the original and the target data on the right 1D 

plot (blue for original, red for target). The same compound should overlap on 

the 1D plot if a correct Relative 2D shift is used. If Universal Y Scale above 

the 1D plot is activated, the original and the target 1D plot will share the same 

Y scale so their intensities can be directly compared. 

 

 

In addition, click Subtract button, the original data will subtract the target data 

and the differential chromatogram will be displayed in the 2D View panel. Red 

color means positive value, and blue means negative. Click  to resume the 

original 2D chromatogram. 

 

 

Hints: You must click on the Original 2D chromatogram, not the Target 2D 

chromatogram, to show the comparison with two data in the 1D plot. 
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Chapter 10. Batch Analysis 

 

When Lock Template File for New Data is checked in the Cluster View 

window (under Lock Template mode), the Miscellaneous is activated in Menu.  

 

Two Batch Analysis Methods are available from Miscellaneous Menu. 

• Multi Samples 

• Batch Data 

 

 

 

Multi Samples 

After a data is speciated and templates are locked, select “Miscellaneous → 

Multi Samples” to show the Sample Investigation Chart. Press Add Result 

to import the cluster quantitation results of the current data. 
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Close the Sample Investigation Chart and proceed to the next sample. Follow 

the same method under Lock Template mode to do speciation and template 

application. Adjust the results if necessary, e.g., manual integration or cluster 

modification. Select Multi Samples and add the result of the new data for 

comparison. 

 

After all the data are imported, the final comparison result is shown in the chart. 

Choose a Chart Type and Sample Type. The results can be exported and 

saved as a .txt file. 

  

 

 

Batch Data 

Multi Samples function requires to open all the sample data files to be 

compared one by one, with standard speciation and template application 

procedures, sometimes manual integration and cluster modifications as well. 

On the other hand, Batch Data function loads all the data to be compared at 

once and the same speciation and template match applications are processed 

automatically. Batch Data allows much faster and more convenient analysis 

for multiple data, but user will not see the chromatograms and template match 
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results for all the samples. So manual inspections should be conducted if 

suspicious results appear. 

 

Select “Miscellaneous → Batch Data” to open the Batch Data window and 

click Browse to load all the data files at once. Enter the start and end time of 

the data. A 2D-Shift Ref cluster is usually needed for accurately matching the 

template in the secondary dimension between different data files.  

 

 

 

Click Process and all the data will be analyzed with the same speciation and 

template match procedures. Use Show Result to present the comparison result 

in the Sample Investigation Chart as discussed in Multi Samples.  
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Chapter 11. Report Output 

 

By selecting “File → Generate Report”, an analysis report of the current data 

can be generated in PDF format and saved under the same path of the data. 

Adobe Reader should be installed. 

 

 

 

In addition, the current 2D chromatogram data can be exported as a csv text 

file using “File → Export to CSV”. Choose the following export format.  
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1D Raw Data is the raw data shown in the current 2D View plot, which includes 

two columns, one being the time (min) and the other the signal. It can be used 

to transform a special-format data file (.D; .ch; .raw;…) to a common csv file. It 

can also save a TIC or an EIC data of a MS data to a csv file, discarding all MS 

information.  

 

1D Projection is a 1D data with all the signals in every modulation period 

summed together (projected) in the first dimension, which is the chromatogram 

shown in the 1D Projection plot. 

  

2D Matrix converts the raw data to a GC×GC data according to the modulation 

period. This data can be used to visualize the 2D chromatogram or 3D surface 

plot in other data processing software.  

 

All the 2D chromatograms, 1D projections, 1D spot view and 3D surface plots 

can be saved as image files. And a Library Image can also be exported for 

Canvas Library use by “File → Save to 2D Library Image” (Canvas Library is 

an add-on functions, see Add-on Functions in Plugin Packages). 
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Chapter 12. Add-on Functions in Plugin Packages 

 

Several add-on functions can be purchased as plugin packages inside Canvas. 

These packages include: 

 

• Canvas Library for GC×GC applications 

GC×GC applications are obtained and organized in this library with 

sample information, GC×GC column configuration, instrumental 

conditions, and GC×GC chromatogram for reference.  2D Library Image 

(see Report Output) is used in this Library. 

 

• GC×GC Simulation 

A software that simulates the GC×GC chromatogram of selected 

compounds with standard column configurations and experimental 

conditions, without actually running the experiment. 

 

• Dedicated Application Packages 

These packages streamline the standard data analysis procedures for 

routine or standard applications in oil and petroleum, environmental, 

flavor and fragrant industries, etc. Select your special packages to 

simplify your data analysis procedure. 

 

More specific functions are under development. Consult J&X for our latest 

products. 
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